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มากมาย นับได้ว่าเป็นเวอร์ชันที่พัฒนาแบบก้าวกระโดดอีกครั้งหนึ่งในโลกของ .NET
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ผู้เขียนข้างต้น
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CHAPTER

01

1

โลกของการเขียนโปรแกรมไม่ได้มีแต่เพียงแค่พัฒนาโปรแกรมบน PC เพียงอย่างเดียวเท่านั้น แต่ยังรวม

ไปถึงมือถือและแท็บเล็ตอีกด้วย

ไมโครซอฟต์พัฒนา Visual Studio 2015 (เรียกสั้นๆ ว่า VS 2015) ขึ้นมา เพื่อรองรับการพัฒนา

โปรแกรม 3 ช่องทาง คือ

1. พัฒนาโปรแกรมส�าหรับ PC (หรือ Notebook) 

2. พัฒนาโปรแกรมบนเว็บ (ไม่ขึ้นกับแพลตฟอร์ม) 

3. พัฒนาโปรแกรมส�าหรับมือถือและแท็บเล็ต

ในปัจจุบันไมโครซอฟต์พัฒนา Windows 10 ขึ้นมา ท�าให้โลกของโปรแกรมบน PC, มือถือและแท็บเล็ต 

กลายเป็นโลกเดียวกัน ส่งผลให้นักพัฒนาไม่ต้องเสียเวลาเรียนรู้ซ�้าซ้อนหลายขั้นตอนอีกต่อไป

เนื้อหาที่จะน�าเสนอในหนังสือเล่มน้ี ครอบคลุมการพัฒนาโปรแกรมบน Desktop, Web, มือถือ และ

แท็บเล็ต โดยอาศัยภาษา Visual Basic 2015 (เรียกสั้นๆ ว่า VB 2015) ที่มีเนื้อหาสาระเพียงพอที่จะต่อยอด

เป็นโปรแกรมเมอร์มืออาชีพในล�าดับต่อไปได้ไม่ยาก
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รูปที่ 1-1

แสดงหน้าเว็บเพจ
ที่ให้ดาวน์โหลด 
Visual Studio

รูปที่ 1-2

แสดงการติดตั้งโปรแกรม 
Visual Studio 2015 
Community Edition

3. การติดตั้ง Visual Studio 2015 ให้เลือกแบบ Typical ซึ่งเป็นการติดตั้งแบบปกติ (ไม่รวมโปรเจ็กต์

ประเภท Windows 10 Apps)

4. คลิกปุม 

5. คลิกปุม LAUNCH

กรอก1

คลิก 22

คลิก 4 คลิก5

เลือก3

กำรดำวน์โหลดและติดตั้ง Visual Studio 2015
ผูอ่้านสามารถเขยีนโปรแกรมในตระกลู .NET ได้โดยการใช้โปรแกรมทีช่ือ่ว่า Visual Studio ซึง่มขีัน้ตอนดงันี้

1. ให้ไปท่ีเว็บไซต์ https://www.visualstudio.com/downloads/download-visual-studio-vs เพื่อ

ดาวน์โหลดโปรแกรม Visual Studio เวอร์ชันล่าสุดเท่าที่มีอยู่ในปัจจุบัน ดังรูปที่ 1-1

2. ให้ผู้อ่านคลิกดาวน์โหลดเวอร์ชัน Community Edition มาใช้งานได้ฟรี

ในกรณีทีผู้่อ่านต้องการพฒันา Windows 10 Apps ด้วย ให้ตดิตัง้ Visual Studio 2015 บน Windows 10 

และเลือกติดตั้งแบบ Custom โดยเลือกตัวเลือกดังรูป
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รูปที่ 1-3

กรณีติดตั้ง Visual 
Studio แบบ
Custom

กำรต้ังคำ Visual Studio 2015 เบ้ืองต้น
ก่อนเริ่มต้นเขียนเรียนรู้การพัฒนาแอพพลิเคชันด้วย Visual Studio 2015 ผู้เขียนอยากจะแนะน�าให้

ผู้อ่านรู้จักการตั้งค่าต่างๆ ที่ช่วยให้การพัฒนาแอพพลิเคชันต่างๆ ง่ายขึ้นดังนี้

กำรก�ำหนดให้แสดงไดอะล็อกเลือกโปรเจ็กต์ (New Project Dialog)
เพื่อเป็นการอ�านวยความสะดวกในการสร้างโปรเจ็กต์ใหม่ทุกครั้ง ผู้อ่านสามารถก�าหนดให้ VS แสดง

ไดอะล็อกเลือกสร้างโปรเจ็กต์ทุกครั้ง เมื่อมีการเปด Visual Studio 2015 ขึ้นมา โดยมีขั้นตอนดังนี้

1. คลิกเมนู Tools > Options...

2. จะปรากฏไดอะล็อก Options ให้คลิกเลือก Environment > Startup 

3. คลิกเลือก Show New Project dialog box 

4. คลิกปุม 

จากรปูที ่1-3 ทีร่ายการ Universal 

Windows App Development Tools 

ให้ผู ้อ ่านเลือกติดตั้งเพิ่มเติม คือ ตัว 

Windows10 SDK กับ Emulator ส�าหรับ

รันบนมือถือ Windows 10

รูปที่ 1-4

แสดงการเลือก
รายการ Show 
New Project 
dialog box

คลิก 1

รายการที่ตองติดตั้งเพิ่มเติม
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รูปที่ 1-5

แสดงไดอะล็อก
เลือกสร้าง
โปรเจ็กต์ใหม่

5. จะปรากฏไดอะล็อกส�าหรับสร้างโปรเจ็กต์ใหม่ดังรูป

เลือก2

เลือก 3

คลิก 4

จากรปูที ่1-5 ผูอ่้านสามารถเลอืกสร้างโปรเจ็กต์ใน Visual Studio 2015 ได้ตามทีต้่องการจากไดอะลอ็กนี้

กำรก�ำหนดให้แสดงหมำยเลขก�ำกับโค้ดในแตละบรรทัด
การก�าหนดให้ Visual Studio 2015 แสดงหมายเลขก�ากับโค้ดในแต่ละบรรทัด ผู้อ่านสามารถท�าได้โดย

มีขั้นตอนดังนี้

1. คลิกเมนู Tools > Options...

2. จะปรากฏไดอะล็อก Options ให้คลิกเลือก Text Editor > All Languages 

3. คลิกเลือก  Line numbers 

4. คลิกปุม 

รูปที่ 1-4 (ตอ)

แสดงการเลือก
รายการ Show 
New Project 
dialog box
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รูปที่ 1-6

แสดงการกําหนด
ให้แสดงหมายเลข
กํากับโค้ดแต่ละ
บรรทัด

คลิก 1

คลิก2

เลือก3

คลิก 4

กำรสร้ำงโปรเจ็กต์ใหม
การสร้างโปรเจก็ต์ใหม่ถอืเป็นจดุเริม่ต้นของการพฒันาแอพพลเิคชนัต่างๆ ในทีน่ีจ้ะเริม่ต้นจาก Windows 

Forms Application ซึ่งเป็นโปรเจ็กต์หลักของ Visual Basic 2015 โดยมีขั้นตอนดังนี้

1. ให้ผู้อ่านคลิกเมนู File > New > Project… 

2. คลิกเลือก Visual Basic > Store Apps > Windows Desktop

3. เลือกสร้างโปรเจ็กต์แบบ Windows Forms Application ซี่งเป็นโปรเจ็กต์ที่ใช้สร้างโปรแกรมส�าหรับ

ท�างานบน Windows 

4. กรอกชื่อโปรเจ็กต์

5. เลือกต�าแหน่งที่อยู่ของโปรเจ็กต์

6. คลิกปุม 
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7. จะปรากฏหน้า Windows Forms Application ส�าหรับสร้างโปรเจ็กต์ดังรูป

รูปที่ 1-8

แสดงสภาพ
แวดล้อมของ VS 
แบบ Windows 
Forms Applica-
tion

คลิก2

กรอกชื่อ4

เลือก3

คลิก5

คลิก 6

คลิก1

รูปที่ 1-7

แสดงการสร้างโปรเจ็กต์
แบบ Windows Forms 
Application
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รูปที่ 1-9

แสดงไดอะล็อก
สร้างโปรเจ็กต์
ประเภทต่างๆ 
ของ Visual 
Studio 2015

ท�ำควำมรู้จักกับโปรเจ็กต์ประเภทอื่นๆ ของ Visual Studio 2015
นอกเหนือไปจากโปรเจ็กต์ประเภท Windows Forms Application แล้ว ตัวโปรแกรม Visual Studio 

2015 ยังรองรับการพัฒนาแอพฯ ประเภทต่างๆ อีกมากมาย 

โปรเจ็กต์ประเภท Windows
โปรเจ็กต์ประเภท Windows ยังถูกแบ่งออกเป็น 3 ประเภท คือ
z	 Universal เป็นการพัฒนาแอพฯ ที่รันบนระบบปฏิบัติการ Windows 10 โดยสามารถสร้างโปรเจ็กต์

ขึ้นมาเพียง 1 โปรเจ็กต์ แต่แอพฯ ที่ได้น�ามารันได้ทั้ง PC แท็บเล็ต และมือถือ
z	 Windows 8 เป็นการพัฒนาแอพฯ ที่รันบนระบบปฏิบัติการ Windows 8/8.1 เท่านั้น
z	 Classic Desktop เป็นการพัฒนาแอพแบบที่เราคุ้นเคยกันเป็นอย่างดี แอพฯ ที่ได้มาก็คือ ไฟล์ exe 

สามารถติดตั้งในระบบปฏิบัติการ Windows ต่างๆ ที่มีการติดตั้ง .NET Framework ตามเวอร์ชันที่

เราเป็นผู้สร้างโปรเจ็กต์ขึ้นมา

โปรเจ็กต์ประเภท Web
ถ้าต้องการสร้างเว็บไซต์ต่างๆ เช่น เว็บแสดงรูปภาพ, เว็บบอร์ด, เว็บข่าวสาร ฯลฯ แสดงผลในบราวเซอร์ 

เราถือว่าเป็นโปรเจ็กต์ประเภท Web อยู่ในความรับผิดชอบของภาษา ASP.NET

โปรเจ็กต์ประเภท JavaScript
เดิมทีเดียวภาษา JavaScript ถูกน�ามาใช้พัฒนาด้าน Web Application เพียงอย่างเดียวเท่านั้น แต่ใน

ปัจจุบันภาษา JavaScript ถูกน�ามาพัฒนาแอพฯ ได้ทั้งแบบ Web Apps กับ Mobile Apps อีกด้วย



Professional Visual Basic 20158

รูปที่ 1-10

แสดงโปรเจ็กต์
ประเภท
JavaScript

จากรปูที่ 1-10 ภาษา JavaScript ใน Visual Studio 2015 ในขัน้ตน้สามารถสร้างโปรเจ็กต์ได้ 3 แบบ คอื
z	 Apache Cordova Apps เป็นการใช้งานภาษา JavaScript ร่วมภับภาษา HTML5 เพื่อสร้างแอพฯ 

ที่สามารถรันบนมือถือ โดยอาศัย Cordova (อาจจะเรียกว่า PhoneGap ก็ได้)
z	 Node.js เป็นการพัฒนา Web Apps ที่รันได้ทั้งฝั่ง Server/Client โดยอาศัยภาษา JavaScript เพียง

ภาษาเดียว
z	 Windows – Universal เป็นการพัฒนาแอพฯ ที่รันบน Windows 10 (PC, แท็บเล็ตและมือถือ) 

โดยอาศัยภาษา HTML5 ร่วมกับภาษา JavaScript

โปรเจ็กต์ประเภท TypeScript
ภาษา TypeScript เป็นภาษาใหม่ที่ไมโครซอฟท์สร้างขึ้นมา โดยมีหลักการที่ว่าทุกสิ่งทุกอย่างของภาษา 

JavaScript คือ ภาษา TypeScript และเพิ่มเติมความสามารถอื่นๆ ในตัวภาษา TypeScript อีกด้วย เช่น การ

ก�าหนดประเภทข้อมูล, การสร้างคลาสขึ้นมาใช้งานเองได้ เป็นต้น ปัจจุบันเป็นภาษาสคริปต์ท่ีก�าลังได้รับความ

นิยมเป็นอย่างมาก

จากรปูที ่1-11 ภาษา TypeScript ใน Visual Studio 2015 ในขัน้ต้นสามารถสร้างโปรเจ็กต์ได้ 2 แบบ คอื
z	 Apache Cordova Apps เป็นการใช้งานภาษา TypeScript ร่วมภับภาษา HTML5 เพื่อสร้างแอพฯ 

ที่สามารถรันบนมือถือ โดยอาศัย Cordova (อาจจะเรียกว่า PhoneGap ก็ได้)
z	 Node.js เป็นการพัฒนา Web Apps ที่รันได้ทั้งฝั่ง Server/Client โดยอาศัยภาษา TypeScript เพียง

ภาษาเดียว
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รูปที่ 1-11

แสดงโปรเจ็กต์
ประเภท Type-
Script

โปรเจ็กต์ประเภท Cloud
ในปัจจุบันการขอใช้บริการต่างๆ บนก้อนเมฆ (Cloud) ได้รับความนิยมเป็นอย่างสูง และบริการ Cloud 

ของไมโครซอฟท์ชื่อว่า Azure เราสามารถสร้างโปรเจ็กต์ได้ 2 รูปแบบใหญ่ๆ คือ
z	 โปรเจ็กต์ประเภท ASP.NET Web Application เป็นการพัฒนา Web Apps ด้วยภาษา ASP.NET 

เพื่อขอใช้บริการต่างๆ ใน Azure
z	 โปรเจ็กต์ประเภท Azure Mobile Service เป็นการสร้างบริการที่เชื่อมต่อกับ Azure ให้บริการด้าน

ต่างๆ โดยอาศัยโครงสร้างของ Web API ส�าหรับอุปกรณ์ประเภท Mobile Devices ต่างๆ

ประเภทโปรเจ็กต์ที่ผู้เขียนน�าเสนอรายละเอียดในขั้นต้นนี้ เป็นการติดตั้งเพิ่มเติมแยกต่างหาก เพื่อแสดง

ให้เห็นความสามารถของตัวโปรแกรม Visual Studio 2015 ที่มีอยู่มากมาย

รูปที่ 1-12

แสดงโปรเจ็กต์
ประเภท Cloud
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ท�ำควำมรู้จักกับสภำพแวดล้อม (IDE) ของ VS ในขั้นต้น
VS 2015 รองรับการพัฒนาแอพพลิเคชันหลายแพลตฟอร์ม (PC, มือถือ และแท็บเล็ต) ผู้อ่านสามารถ

เลือกสร้างโปรเจ็กต์ได้ตามต้องการ และสภาพแวดล้อมของโปรเจ็กต์แต่ละประเภทจะมีลักษณะคล้ายกัน เพื่อให้

นักพัฒนาคุ้นเคยนั่นเอง

รูปที่ 1-13

แสดงสภาพแวดล้อม IDE 
ของ VS แบบ Windows 
Forms Application

1

2

4

5

3

ผูเ้ขยีนขอยกตวัอย่างสภาพแวดล้อมของโปรเจก็ต์ประเภท Windows Forms 

Application มาอธิบาย ดังรูปที่ 1-13

z	 หมายเลข 1 แถบเครื่องมือส�าหรับทดสอบโปรเจ็กต์ปัจจุบัน
z	 หมายเลข 2 แถบคอนโทรลส�าเร็จรูปท�าหน้าที่ออกแบบส่วนแสดงผล (User Interface เรียกย่อๆ 

ว่า UI) ภายในโปรเจ็กต์ของผู้อ่าน
z	 หมายเลข 3 ส่วนแสดงผลจ�าลอง ผูอ่้านสามารถออกแบบส่วนแสดงผลให้กบัหน้าจอต่างๆ ได้ทีน่ี ่โดย

การลากคอนโทรลต่างๆ มาวาดตามที่ต้องการ
z	 หมายเลข 4 เรียกว่า หน้าต่าง Solution Explorer ท�าหน้าที่แสดงโครงสร้างโปรเจ็กต์ปัจจุบันของ

ผู้อ่านว่า ประกอบไปด้วยไฟล์อะไรบ้าง
z	 หมายเลข 5 เรียกว่า หน้าต่างคุณสมบัติ (Properties) ท�าหน้าที่แสดงคุณสมบัติต่างๆ ของ

คอนโทรลที่ก�าลังถูกโฟกัสในส่วนแสดงผลจ�าลองว่ามีสมบัติอะไรบ้าง สามารถแก้ไขคุณสมบัติต่างๆ 

ได้ตามที่ต้องการเช่นกัน เช่น ตั้งชื่อคอนโทรลได้ที่คุณสมบัติ Name, ก�าหนดสีพื้นหลังได้ที่คุณสมบัติ 

BackColor เป็นต้น
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รูปที่ 1-14

แสดงแถบ 
Toolbox

มือใหมต้องทรำบกอนเขียนโปรแกรมในโลกของ .NET
ก่อนทีจ่ะเข้าสู่รายละเอียดของการเขยีนโปรแกรมในโลกของ .NET Frawework ผู้เขยีนจะขอน�าเสนอหลกั

การพ้ืนฐานในภาพกว้างท่ีมอืใหม่ต้องทราบในข้ันต้นเสียก่อน เพ่ือปูพ้ืนฐานก่อนทีจ่ะเข้าสู่รายละเอยีดเนือ้หาส่วน

ต่างๆ ในแต่ละบทต่อไป

กำรออกแบบสวนแสดงผลด้วยคอนโทรล ( User Interface)
ไม่ว่าจะสร้างโปรเจ็กต์ประเภทใดก็ตามใน Visual Studio 2015 ไมโครซอฟท์ก�าหนดให้สภาพแวดล้อม

ของตวัโปรแกรม Visual Studio 2015 มลีกัษณะใกล้เคยีงกนัมากทีส่ดุเท่าทีจ่ะเป็นไปได้ เพือ่ให้นกัพฒันาคุน้เคย

กับตัวโปรแกรมได้ไม่ยาก

แม้ว่าภาพประกอบผูเ้ขยีนจะใช้โปรเจก็ต์

ประเภท Windows Forms Application ก็

จริงอยู่ แต่สามารถเทียบเคียงได้กับโปรเจ็กต์

ประเภทอื่นๆ ได้ 

ก่อนอื่นขอให้ผู้อ่านสร้างโปรเจ็กต์แบบ 

Windows Forms Application ว่างๆ ขึ้นมา 1 

โปรเจ็กต์ ดังรูปที่ 1-14

จากรปูท่ี 1-14 แถบคอนโทรล (Control) อยูด้่านซ้ายมอื ท�าหน้าทีอ่อกแบบส่วนแสดงผล (User Interface 

เรียกย่อๆ ว่า  UI) ในขั้นต้นนี้ผู้อ่านสามารถใช้งานคอนโทรลนี้ได้ 2 วิธี

1. ดบัเบลิคลิกทีตั่วคอนโทรลเพือ่ก�าหนดให้ Visual Studio ใช้งานคอนโทรลดงักล่าว ในหน้าจอออกแบบ

โดยอัตโนมัติ เช่น ผู้เขียนต้องการใช้ปุมกด Button1 ดังรูปที่ 1-15

รูปที่ 1-15

แสดงการใช้ปุมกด
ด้วยวิธีการ
ดับเบิลคลิกใน
แถบ Toolbox

ดับเบิลคลิก1.1

คอนโทรล Button1.2
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2. คลิกเลือกคอนโทรลที่ต้องการใช้งานแล้วน�าไปวาดในส่วนของฟอร์ม (Form) ดังรูปที่ 1-16

รูปที่ 1-16

แสดงการใช้ปุมกด 
ด้วยวิธีวาด

รูปที่ 1-17

แสดงรายการ
คุณสมบัติของปุม
กด Button

เลือก2.1

จากรูปที่ 1-16 เราได้ส่วนแสดงผลง่ายๆ มาแล้ว 1 หน้าจอ โดยมีปุมกด Button 1 ปุม

กำรปรับแตงคอนโทรลด้วยวิธีแก้ไขคุณสมบัติ ( Property)

วาด 2.2
คอนโทรล Button2.3

คอนโทรลต ่างๆ ท่ี

น�ามาใช้งาน สามารถปรับ

แต่งหรือแก้ไขได้ในหน้าต่าง

คณุสมบตั ิ( Properties) กล่าว

คอื เมือ่โฟกสัทีค่อนโทรลตวัใด

ก็ตาม หน้าต่างคุณสมบัติจะ

เปลี่ยนไปโดยอัตโนมัติ

เลือก1

แสดงผล 2

จากรูปที่ 1-17 ส่วนแสดงผลปัจจุบันของผู้เขียนมีเพียง 1 ปุม เมื่อถูกโฟกัสแล้วหน้าต่างคุณสมบัติก็จะ

แสดงรายการคุณสมบัติต่างๆ ของคอนโทรล Button ให้เราโดยอัตโนมัติ

รายการคุณสมบัติของคอนโทรล  Button ที่น่าสนใจ แสดงดังตารางต่อไปนี้

คุณสมบัติ หน้าที่

 Name ท�ำหน้ำที่ตั้งชื่อให้กับตัวคอนโทรล ใช้ส�ำหรับอ้ำงอิงตอนเขียนโค้ด

 Text ก�ำหนดข้อควำมที่จะแสดงในปุมกด

 BackColor ก�ำหนดสีพื้นหลังให้กับปุมกด

 ForeColor ก�ำหนดสีตัวอักษรที่อยู่ในปุมกด
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รูปที่ 1-18

แสดงรายการ
คุณสมบัติของ
โทรล Label

คุณสมบัติใดก็ตามท่ีถูกแก้ไขจะแสดงด้วยตัวอักษรตัวหนา ส่วนตัวอักษรปกติ หมายถึง เป็นค่าเร่ิมต้น

ท่ีโปรแกรม Visual Studio ตั้งไว้ ในการใช้งานคอนโทรลไม่จ�าเป็นต้องไปแก้ไขให้ครบทุกคุณสมบัติ โดยแก้ไข

เฉพาะเท่าที่ต้องการเปลี่ยนแปลงเท่านั้น

ต่อมา ผู้เขียนลองใช้คอนโทรล Label ซึ่งท�าหน้าที่แสดงข้อความ เมื่อคอนโทรล Label ได้รับโฟกัส พบว่า 

ที่หน้าต่างคุณสมบัติก็จะแสดงรายการคุณสมบัติของคอนโทรล  Label ให้เราโดยอัตโนมัติ

เลือก1

แสดงผล 2

รายการคุณสมบัติที่น่าสนใจแสดงดังตารางต่อไปนี้

คุณสมบัติ หน้าที่

Name ท�ำหน้ำที่ตั้งชื่อให้กับตัวคอนโทรลใช้ส�ำหรับอ้ำงอิงตอนเขียนโค้ด

Text ก�ำหนดข้อควำมที่จะแสดงใน Label

BackColor ก�ำหนดสีพื้นหลังให้กับคอนโทรล Label

ForeColor ก�ำหนดสีตัวอักษรที่อยู่ในคอนโทรล Label

 AutoSize ก�ำหนดขนำดของคอนโทรล Label มี 2 แบบ คือ

z	 ·True หมำยถึง ก�ำหนดให้ Label มีขนำดเท่ำที่ข้อควำมแสดงอยู่

z	 ·False หมำยถึง คุณสำมำรถก�ำหนดขนำดของ Label ได้อย่ำงอิสระ

คอนโทรลแต่ละตัวก็จะมีรายการคุณสมบัติทั้งที่เหมือนกันและต่างกันไปตามหน้าที่ของตัวมันเอง
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ท�ำควำมรู้จักกับฟอร์ม (Form)

จากรูปที่ 1-19 เมื่อโฟกัสที่ Form1 หน้าต่างคุณสมบัติก็จะแสดงรายการคุณสมบัติของ Form1 เช่นกัน 

โดยคุณสมบัติที่น่าสนใจก็คือ

คุณสมบัติ หน้าที่

Name ท�ำหน้ำที่ตั้งชื่อให้กับฟอร์มใช้ส�ำหรับอ้ำงอิงตอนเขียนโค้ด

Text ก�ำหนดข้อควำมที่จะแสดงในแถบ Title Bar

BackColor ก�ำหนดสีพื้นหลังให้กับฟอร์ม

ForeColor ก�ำหนดสีตัวอักษรที่อยู่ในฟอร์ม

รูปที่ 1-19

แสดงรายการ
คุณสมบัติของ
ฟอร์ม

รูปที่ 1-20

แสดงการแก้ไข
คุณสมบัติ Text 
ของ Form1

ไม่ว่าจะสร้างโปรเจ็กต์ประเภท

ใดก็ตาม โดยส่วนใหญ่ (โปรเจ็กต์บาง

ประเภทไม่ต้องมีส่วนแสดงผลเริ่มต้น)  

จะมีส ่วนแสดงผลเริ่มต ้นมาให ้ ใช ้

ออกแบบหน้าจอแรก เช่น ในกรณีนี้เรา

สร้างโปรเจ็กต์แบบ Windows Forms 

Application ก็จะได้ฟอร์ม (Form) ท่ี

มีชื่อว่า Form1 เป็นหน้าจอเริ่มต้น ดัง

รูปที่ 1-19
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รูปที่ 1-21

แสดงการเพิ่ม
ฟอร์มที่ชื่อว่า 
Form2 เข้ามาใน
โปรเจ็กต์

กำรเพิ่มฟอร์มใหมเข้ำมำในโปรเจ็กต์
ในการพฒันาแอพฯ ขึน้มาใช้งาน โดยส่วนใหญ่จะประกอบไปด้วยส่วนแสดงผลตัง้แต่ 2 หน้าจอขึน้ไป วิธกีาร

เพิ่มหน้าจอใหม่เข้ามา ให้ผู้อ่านคลิกเมนู Project > Add New Item… ในกรณีนี้เราต้องการเพ่ิมหน้าจอใหม่

ประเภท Windows Forms Application โดยตั้งชื่อว่า Form2 ดังรูปที่ 1-21

เลือก1

จากรูปที่ 1-21 ณ จุดนี้ โปรเจ็กต์ของเรามี 2 ฟอร์มแล้ว

เร่ิมต้นสร้ำงแอพพลิเคชันแรก
ในหัวข้อนี้ผู้อ่านจะได้ใช้งาน Visual Studio 2015 เขียนโปรแกรมด้วยภาษา Visual Basic 2015 เป็น

ครั้งแรก โดยเปาหมายของแอพพลิเคชันนี้ก็คือ แสดงข้อความ “Hello VB” โดยมีขั้นตอนดังนี้

1. ให้ผู้อ่านเลือกใช้คอนโทรล Label เข้ามาท�าหน้าที่แสดงข้อความ “Hello VB” โดยการลาก & วางใน 

Form1 ซึ่งท�าหน้าที่เป็นส่วนแสดงผล ดังรูปที่ 1-22

คลิก2

เลือก3

ตั้งชื่อ4 คลิก 55
ฟอรมใหม6
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2. ก�าหนดข้อความใน Label ตวันี ้ให้ผู้อ่านก�าหนดทีค่ณุสมบัต ิText ในหน้าต่าง Properties เป็นข้อความ

ตามที่ต้องการ

รูปที่ 1-22

แสดงการใช้งาน
คอนโทรล Label 
ใน Form1

รูปที่ 1-23

แสดงการแก้ไข
คุณสมบัติ Text 
ของคอนโทรล 
Label ตัวนี้

ลากวาง1

3. ก�าหนดให้ Form1 ปรากฏอยู่กึ่งกลางหน้าจอ โดยโฟกัสที่ Form1 ก่อน (คลิกเลือกที่ Form1) ใน

หน้าต่าง Properties ที่คุณสมบัติ  StartPosition ซึ่งท�าหน้าที่ก�าหนดต�าแหน่งของ Form1 ให้ผู้เขียน

เลือกเป็นแบบ CenterScreen คอื เมือ่โปรแกรมท�างานก�าหนดให้ Form1 ปรากฏขึน้มากึง่กลางหน้าจอ 

ดังรูปที่ 1-24

กําหนดคา2
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รูปที่ 1-24

แสดงการแก้ไข
ตําแหน่งของ
ฟอร์ม ให้อยู่
กึ่งกลางหน้าจอ

กําหนดคา3

จากรูปที่ 1-24 ณ จุดนี้ เราได้โปรเจ็กต์ตามที่เราต้องการแล้ว

กำรทดสอบโปรเจ็กต์
หลังจากที่ผู้อ่านออกแบบและเขียนโค้ดแล้ว ก็จะเข้าสู่ขั้นตอนการทดสอบโปรเจ็กต์เพ่ือดูแอพพลิเคชันที่

สร้างขึน้มผีลการท�างานเป็นไปตามทีเ่ราต้องการหรอืไม่ โดยการคลกิปุม  เพือ่เริม่ต้นทดสอบรนัโปรเจก็ต์

รูปที่ 1-25

แสดงการเริ่ม
ทดสอบโปรเจ็กต์

รูปที่ 1-26

ผลการทํางานของ
โปรเจ็กต์ปจจุบัน

คลิก1

จากรูปที่ 1-26 เห็นได้ว่า เราได้ข้อความ 

“Hello VB” ปรากฏขึ้นมาใน Form1 ตามที่เรา

ต้องการแล้ว
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วิธีกำรส่ังให้เปดฟอร์มใหมโดยกำรเขียนโค้ด
ส�าหรับวิธีการสั่งให้เปดฟอร์มใหม่ที่เราเพิ่มเข้ามามีขั้นตอนดังนี้

1. ดับเบิลคลิกปุม Button1 เพื่อสร้างเหตุการณ์ Click() 

2. เขียนโค้ด ดังรูปที่ 1-27

รูปที่ 1-27

แสดงโค้ดที่ใช้
สําหรับเปด 
Form2

รูปที่ 1-28

แสดงโค้ดที่ใช้
สําหรับเปด 
Form2

3. ทดสอบรันโปรเจ็กต์ พบว่า เราสามารถเปด Form2 ได้แล้ว ดังรูปที่ 1-28

ดับเบิลคลิก1

เขียนโคด2

หลักกำรท�ำงำนของภำษำ VB
หลักการท�างานของภาษา VB เรียกว่า การเขียนโปรแกรมตอบสนองเหตุการณ์ที่เกิดขึ้น ( Event 

Driven Programming) กล่าวคือ ผู้อ่านเป็นผู้ก�าหนดเองว่า เมื่อเกิดเหตุการณ์ Click() ให้ท�าอะไร, เมื่อเกิด

เหตุการณ์ Load() ให้ท�าอะไร เป็นต้น

หมายความว่า แท้ทีจ่รงิแล้วการกระท�าต่างๆ ทีผู่ใ้ช้งานกระท�าต่อโปรแกรมของผูอ่้าน ผูอ่้านเป็นผูก้�าหนด

ข้ึนมาเองทั้งสิ้นว่า “ให้ท�าอะไร” ประเด็นท่ีตามมา ก็คือ วิธีการการสร้างเหตุการณ์ให้กับคอนโทรลแต่ละตัวท�า

อย่างไร 

คลิก3

ฟอรมใหมถูกเพิ่มเขามาโดยการคลิกเมนู Project > Add Windows Forms...
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รูปที่ 1-29

แสดงการใช้งาน
คอนโทรล Button 
ใน Form1

โดยการสร้างเหตุการณ์ให้กับปุมกด Button1 นี้ มี 2 วิธี ดังข้อที่ 2 กับ 3

2. ดบัเบลิคลกิทีค่อนโทรล Button1 เพือ่สัง่ให้ VS สร้างเหตกุารณ์ประจ�าตวัของคอนโทรล Button ขึน้มา 

พบว่า เหตุการณ์ประจ�าตัวของคอนโทรล Button ก็คือ เหตุการณ์ Click() เพราะคอนโทรล Button 

ถูกสร้างขึ้นมาเพื่อท�าหน้าที่รองรับการคลิกจากผู้ใช้งาน

ลากวาง1

รูปที่ 1-30

แสดงการสร้าง
เหตุการณ์ Click() 
ด้วยวิธดีบัเบิลคลิก

แต่ละคอนโทรลมีเหตุการณ์ประจ�าตัวแตกต่างกัน ขึ้นอยู่กับว่าคอนโทรลตัวนั้นๆ ถูกสร้างขึ้นมาเพื่อ “ท�า

หน้าที่อะไร”

3. อีกวิธีหนึ่ง ก็คือ ให้ผู้อ่านโฟกัสที่คอนโทรล Button1 ก่อน จากนั้นคลิกปุม  ในหน้าต่าง Properties 

เพื่อเลือกสร้างเหตุการณ์ที่เราต้องการ จะเห็นได้ว่า ปุมกด Button สามารถรองรับได้หลายเหตุการณ์ 

ให้ผู้อ่านดับเบิลคลิกที่ Click เพื่อสร้างเหตุการณ์ Click() ขึ้นมาส�าหรับปุมกด Button1 ปุมนี้

สมมติว่า ผู้เขียนต้องการสร้างเหตุการณ์ Click() ให้กับปุมกด Button จะมีวิธีการดังนี้

1. ให้ผู้อ่านลากปุมกด Button มาวางใน Form1 ดังรูปที่ 1-29

รูปที่ 1-31

แสดงเหตุการณ์ 
Click() ที่ได้จาก
วิธีเลือกสร้าง
เหตุการณ์

คลิก3.2

เลือก3.1

ดับเบิลคลิก3.3
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4. ผู้เขียนลองตั้งโจทย์ง่ายๆ ว่า ต้องการแสดงข้อความ “Hello VB” เมื่อผู้ใช้งานคลิกปุม Button1 ซึ่ง

สามารถท�าได้โดยการเขียนโค้ดดังต่อไปนี้

Form1.vb
Public Class Form1
    Private Sub Button1_Click(sender As Object, e As EventArgs) Handles Button1.Click
        MessageBox.Show("Hello VB", "คําทักทาย")
    End Sub
End Class

5. จากโค้ดข้างต้นเป็นการสั่งให้แสดงข้อความ “Hello VB” โดยอาศัยคลาส MessageBox เข้ามาท�า

หน้าที่สร้างไดอะล็อกแสดงข้อความ เมื่อรันโปรแกรมและมีการคลิกปุม Button1 ดังรูปที่ 1-32

6. ในกรณีทีผู้่อ่านดบัเบลิคลกิบรเิวณพืน้ทีว่่างๆ ของ Form1 ส่งผลให้ VB สร้างเหตกุารณ์ Load() ขึน้มา 

เพื่อให้ก�าหนดว่า เมื่อ Form1 ถูกโหลดขึ้นมาแล้วให้ท�าอะไร เพราะเหตุการณ์ประจ�าตัวของ Form ก็

คือ เหตุการณ์ Load()

รูปที่ 1-32

แสดงข้อความที่ได้

รูปที่ 1-33

แสดงที่จัดเก็บโค้ด
ภาษา VB

คลิก5.1

แสดงผล5.2

รูปที่ 1-33 ที่หน้าต่าง Solution Explorer ท�าหน้าที่แสดงโครงสร้างของโปรเจ็กต์ปัจจุบัน ให้ผู้อ่านคลิกที่

รายการ Form1 (.vb) เพื่อแสดงโค้ดทั้งหมดที่อยู่ใน Form1

สรุปท้ำยบท
เนื้อหาในบทนี้เป็นเพียงข้ันตอนการเตรียมและทดสอบสภาพแวดล้อมให้เครื่องของผู้อ่านพร้อมใช้งาน

เท่านั้น เนื้อหาในบทต่อไปจะเข้าสู่โลกของการเขียนโปรแกรมอย่างแท้จริง
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เนื้อหาในบทนี้จะเข้าสู่โลกของการเขียนโปรแกรมกับภาษา VB 2015 ด้วย Visual Studio 2015 ผู้อ่าน

จะได้ศึกษาพื้นฐานและไวยากรณ์ทางภาษาที่ต้องทราบเป็นล�าดับแรกก่อนที่จะเข้าสู่หัวข้อต่อๆ ไป

ค�ำสั่ง Option Explicit On กับ Option Strict On
ทุกครั้งที่ผู้อ่านเริ่มเขียนโค้ดของภาษา VB ควรก�าหนดให้ตัว Editor ของ VS ใช้ค�าสั่ง Option Explicit On 

และค�าสั่ง Option Strict On บริเวณต�าแหน่งบนสุดเสมอ ดังรูปที่ 2-1

โดยความหมายของค�าสั่งทั้ง 2 ข้างต้น มีดังนี้
z	 ค�าสั่ง Option Explicit On หมายถึง ตัวแปรทุกตัวที่ใช้งานต้องมีการประกาศใช้งานด้วยค�าสั่ง Dim 

ก่อนเสมอ
z	 ค�าสั่ง Option Strict On หมายถึง ก�าหนดให้ตัวแปลภาษาของ VB มีความเข้มงวดและเคร่งครัด

ไวยากรณ์ในภาษา VB เทียบเท่ากับภาษา VC# เพื่อให้ได้โค้ดที่มีคุณภาพนั่นเอง

รูปที่ 2-1

แสดงต�ำแหน่งกำร
เขียนค�ำสั่งทั้ง 2

คำ�สั่ง

บทที่ 02 พื้นฐานการเขียนโปรแกรมด้วยภาษา Visual Basic
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กำรประกำศตัวแปรส�ำหรับใช้เก็บข้อมูล
ไม่ว่าผู้อ่านจะเริ่มต้นศึกษาภาษาใดก็ตาม ไวยากรณ์ที่ต้องท�าความเข้าใจเป็นล�าดับแรก คือ การประกาศ

ตวัแปร (Variable) ส�าหรบัท�าหน้าทีเ่กบ็ข้อมลู โดยการประกาศตวัแปรในภาษา VB จะใช้ค�าสัง่ Dim ซึง่มไีวยากรณ์ 

ดังต่อไปนี้

VB 2015

Dim ชื่อตัวแปร As ชนิดข้อมูล [= ค่าข้อมูล]

ตัวอย่างเช่น

Dim intAge As Integer

Dim fGrade As Float

Dim intMoney As Integer = 214

     

กฎกำรตั้งชื่อตัวแปร
ในภาษา VB 2015 การตั้งชื่อตัวแปรต่างๆ ขึ้นใช้งาน มีกฎข้อบังคับดังนี้
z	 ต้องประกอบด้วยอักขระ A–Z, a–z, 0–9 หรือ _ เท่านั้น
z	 อักขระตัวแรกต้องเป็นตัว A–Z, a–z หรือ _ อย่างใดอย่างหนึ่งเท่านั้น (เป็นตัวเลขไม่ได้)
z	 มีความยาวไม่เกิน 1,023 ตัว
z	 ต้องไม่ซ�้ากับ Reserved Words ของ VB

Reserved Words
ในภาษา VB 2015 มี Reserved Words ขั้นต้นที่ก�าหนดให้ห้ามใช้เป็นชื่อตัวแปรต่างๆ ดังนี้

AddHandler AddressOf Alias And

AndAlso As Boolean ByRef

Byte ByVal Call Case

Catch CBool CByte CChar

CDate CDbl CDec Char

CInt Class CLng

CObj Const Continue CSByte

CShort CSng CStr CType

CUInt CULng CUShort Date

Decimal Declare Default Delegate

ชนิดข้อมูล

ชื่อตัวแปร

ค่�ข้อมูล

ชื่อตัวแปร ชนิดข้อมูล
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Dim DirectCast Do Double

Each Else ElseIf End

EndIf Enum Erase

Error Event Exit

Finally For Friend

Function Get GetType

Global GoSub GoTo Handles

If Implements

Imports In

Inherits Integer Interface Is

IsNot Let Lib Like

Long Loop Me Mod

Module MustInherit MustOverride

MyBase Namespace Narrowing

New Next

Not Nothing NotInheritable NotOverridable

Object Of On Operator

Option Optional Or OrElse

Out Overloads Overridable Overrides

ParamArray Partial Private Property

Protected Public RaiseEvent ReadOnly

ReDim REM RemoveHandler Resume

Return SByte Select Set

Shadows Shared Short Single

Static Step Stop String

Structure Sub SyncLock

Then Throw To TRUE

Try TryCast UInteger

ULong UShort Using Variant

Wend When While Widening

With WithEvents WriteOnly Xor

#Const #Else #ElseIf #End
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ขอบเขตของตัวแปร (Variable Scope)
หลังจากท่ีผู้อ่านประกาศตัวแปรที่ต้องการใช้งานแล้ว เนื้อหาล�าดับถัดมาที่ควรรับทราบก็คือ ตัวแปรดัง

กล่าวมีขอบเขตที่สามารถเรียกใช้งานได้แค่ไหน ซึ่งมีขอบเขตอยู่ 3 ระดับ คือ

1. ระดับฟอร์ม ถ้าผู้อ่านประกาศตัวแปรชนิดนี้ไว้ในฟอร์มจะมีขอบเขตกว้างมากที่สุด กล่าวคือ ทุก

เหตุการณ์ที่อยู่ในฟอร์มนั้นๆ จะสามารถเรียกใช้งานได้

2. ระดับ Local หรือเรียกอีกอย่างว่า ระดับ Procedure มีขอบเขตขนาดกลาง เป็นระดับที่เหมาะสมกับ

การใช้งานมากที่สุด คือ มีขอบเขตอยู่ในเหตุการณ์ (Event) แต่ละเหตุการณ์

3. ระดับ Block มีขอบเขตขนาดเล็กที่สุด มักที่จะใช้เก็บค่าข้อมูลแค่ชั่วคราว หรือใช้ในวนลูป (ค�าสั่ง For, 

While) เสียเป็นส่วนใหญ่ เช่น ตัวแปรที่อยู่ในบล็อกของค�าสั่งต่างๆ เป็นต้น

ส�าหรับการเลือกใช้ตัวแปรระดับใดก็ตาม ไม่มีข้อก�าหนดหรือข้อบังคับใดๆ ทั้งสิ้น ขึ้นอยู่กับลักษณะของ

โปรเจ็กต์และความเหมาะสม 

ค�ำว่ำ เหมำะสม หมำยถึง ในกำรเรยีกใช้งำนตวัแปรท้ังหมดทีอ่ยูใ่นโปรเจก็ต์ของผูอ่้ำน สิง่หนึง่ทีต้่องค�ำนงึถงึ 

ก็คือ หน่วยควำมจ�ำ (RAM) กำรเขียนโปรแกรมที่ดีจะต้องมีกำรใช้งำนทรัพยำกรของระบบได้เหมำะสมกับ

ควำมสำมำรถของตัวมันเอง

ขอบเขตของตัวแปรจะเป็นตัวบ่งบอกว่า ตัวแปรนั้นๆ จะมีอายุในการท�างานนานเท่าไร เพราะเมื่อสิ้นสุด

การท�างานของตัวแปรนั้นๆ แอพพลิเคชันจะคืนทรัพยากรที่จองมาใช้งานกลับสู่ระบบ ถ้าผู้อ่านเลือกใช้ขอบเขต

และประเภทของตัวแปรได้อย่างเหมาะสมแล้ว โปรเจ็กต์ที่ได้ก็จะมีทั้งประสิทธิภาพในด้านการท�างานและการใช้

ทรัพยากรระบบ ตัวอย่างเช่น

ผู้เขยีนประกาศตวัแปรขึน้มา 2 ตวั คอื ตวัแปร num ก�าหนดให้มชีนิดข้อมลูเป็นตวัเลขจ�านวนเตม็ Integer 

และก�าหนดค่าเริ่มต้นให้เก็บค่า 1000 ส่วนตัวแปร str ก�าหนดให้มีชนิดข้อมูลเป็นข้อความ String และก�าหนด

ค่าเริ่มต้นเป็นชื่อ-สกุลผู้เขียน

VB 2015
Option Explicit On
Option Strict On

Public Class Form1
    Private Sub Form1_Load(sender As Object, e As EventArgs) Handles MyBase.Load
        Dim num As Integer = 1000
        Dim str As String = "Suphachai Somphanit"

    End Sub
End Class

เหตุก�รณ์

ค่�ข้อมูล

ชื่อตัวแปร
ชนิดข้อมูล
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ตัวแปรทั้ง 2 ตัวถูกประกาศให้อยู่ภายในเหตุการณ์ Form1_Load() เราเรียกตัวแปรประเภทนี้ว่า ตัวแปร
ที่มีขอบเขตแบบ Local หมายถึง สามารถใช้งานได้เฉพาะ “ภายในเหตุการณ์ Form1_Load()” เท่านั้น

ต่อมาผู้เขียนลองประกาศตัวแปรอีกลักษณะหนึ่ง โดยต�าแหน่งที่ประกาศตัวแปรอยู่ภายนอกเหตุการณ์

ต่างๆ กล่าวคือ สร้างตัวแปรที่ชื่อว่า str ขึ้นมา และก�าหนดให้มีชนิดข้อมูลเป็นข้อความ String

VB 2015
Option Explicit On
Option Strict On

Public Class Form1
    Dim str As String = ""

    Private Sub Form1_Load(sender As Object, e As EventArgs) Handles MyBase.Load
        str = "Visual Basic"
    End Sub

    Private Sub Button1_Click(sender As Object, e As EventArgs) Handles Button1.Click
        str = "Visual Basic"
    End Sub
End Class

ในกรณีนี้ตัวแปร str ถูกประกาศอยู่ภายนอกเหตุการณ์ต่างๆ เรียกว่า ตัวแปรที่มีขอบเขตระดับฟอร์ม 

ผู้อ่านสามารถเรยีกใช้ตวัแปร str นี ้ในเหตกุารณ์ต่างๆ ได้ ในกรณนีี ้คอื เหตุการณ์ Form1_Load() กบัเหตกุารณ์ 

Button1_Click()

ตัวแปรระดับ Local และระดับฟอร์ม
เพื่อเพิ่มความเข้าใจในการใช้งานตัวแปรระดับ Local และระดับฟอร์ม ให้ผู้อ่านศึกษาการใช้งานตัวแปร

จากตัวอย่างต่อไปนี้

1. ออกแบบฟอร์มดังรูป 2-2

2. เขียนโค้ดในเหตุการณ์ Form1_Load() ดังนี้

ตัวอย่างที่ 2-1 ตัวแปรระดับ Local และระดับฟอร์ม (Form1.vb)
Option Explicit On
Option Strict On
Public Class Form1
    Dim str As String = "ตัวแปรระดับฟอร์ม"

    Private Sub Form1_Load(sender As Object, e As EventArgs) Handles MyBase.Load
        ‘Dim str As String = "ตัวแปรระดับ Local"
        Label1.Text = str
    End Sub
End Class

เหตุการณ์

เหตุการณ์ Form1_Load
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3. เขียนโค้ดในเหตุการณ์ Button1_Click() ดังนี้

ตัวอย่างที่ 2-1 ตัวแปรระดับ Local และระดับฟอร์ม (Form1.vb)
Option Explicit On
Option Strict On
Public Class Form1
    Dim str As String = "ตัวแปรระดับฟอร์ม"

    Private Sub Form1_Load(sender As Object, e As EventArgs) Handles MyBase.Load
        ‘Dim str As String = "ตัวแปรระดับ Local"
        Label1.Text = str
    End Sub

    Private Sub Button1_Click(sender As Object, e As EventArgs) Handles Button1.Click
        Label2.Text = str
    End Sub
End Class

4. เมื่อรันโปรแกรมจะได้ผลลัพธ์ดังนี้

เหตุการณ์ Button1_Click1

รูปที่ 2-2

ผลการรันตัวอย่าง
ที่ 2-1

รูปที่ 2-3

หลังจากเอา
หมายเหตุออก

จากรูปที่ 2-2 ผู้เขียนประกาศตัวแปรในระดับฟอร์มที่ชื่อว่า str เห็นได้ว่า คอนโทรล Label1 ถูกก�าหนด

ค่าในเหตุการณ์ Form1_Load() ส่วนคอนโทรล Label2 ถูกก�าหนดค่าในเหตุการณ์ Button1_Click() เห็นได้ว่า 

การประกาศตัวแปรในลักษณะนี้ ผู้อ่านสามารถใช้งานตัวแปรตัวนี้ได้หลายเหตุการณ์

5. ให้ผู้อ่านน�าคอมเมนต์โค้ดบรรทัดต่อไปนี้ออก แล้วลองรันตัวอย่างอีกครั้ง ดังรูปที่ 2-3

VB 2015

        Dim str As String = "ตัวแปรระดับ Local"

6. เมื่อรันโปรแกรมจะได้ผลลัพธ์ดังนี้

คอนโทรล Button1

คอนโทรล Label1

คอนโทรล Label2

จากรูปที่ 2-3 ผู้เขียนสร้างตัวแปรอีก 1 ตัว 

มีขอบเขตระดับ Local จงใจให้มีชื่อเดียวกับตัวแปร

ระดับฟอร์มข้างต้น พบว่า คอนโทรล Label1 แสดง

ข้อความของตัวแปรในระดับ Local 

สรุปได้ว่า ถ้ามีตัวแปรชื่อเดียวกันทั้งในระดับ

ฟอร์มกับระดับ Local ตัวแปรที่อยู่ในระดับ Local มี

ความส�าคญัมากกว่าตวัแปรทีอ่ยูใ่นระดบัฟอร์มนัน้เอง

เกิดจาก
ตัวแปรระดับ 
Local



บทที่ 02 พื้นฐานการเขียนโปรแกรมด้วยภาษา Visual Basic 27

ตัวแปรระดับ Block
เพื่อเพิ่มความเข้าใจในการใช้งานตัวแปรระดับ Block ซึ่งเป็นตัวแปรที่มีขอบเขตแคบที่สุด ให้ผู้อ่านศึกษา

การใช้งานตัวแปรจากตัวอย่างต่อไปนี้ 

1. ออกแบบฟอร์มดังรูป 2-4

2. เขียนโค้ดในเหตุการณ์ Form1_Load() ดังนี้

ตัวอย่างที่ 2-2 ตัวแปรระดับ Block (Form1.vb)
Option Explicit On
Option Strict On

Public Class Form1
    Private Sub Form1_Load(ByVal sender As System.Object, ByVal e As System.EventArgs) Handles 
MyBase.Load
        Dim i As Integer
        For i = 0 To 2
            Dim strVal As String = "ตัวแปรระดับ Block" 
            Label1.Text = strVal
        Next
        "Label1.Text = strVal
    End Sub
End Class

ชนดิขอ้มลู

ค่�ข้อมูล

ตัวแปรระดับ Block

3. เมื่อรันโปรแกรมจะได้ผลลัพธ์ดังนี้

รูปที่ 2-4

ผลกำรรันตัวอย่ำง
ที่ 2-2

4. ให้ผู้อ่านเอาคอมเมนต์ออก พบว่า ไม่สามารถอ่านค่าของตัวแปร strVal ตัวนี้นอกลูป For ได้เลย ดัง

รูปที่ 2-5

คอนโทรล 
Label1

รูปที่ 2-5

แสดงกำรใช้งำน
ตัวแปร strVal 
นอกบล็อกค�ำสั่ง

จากรูปที ่2-4 ผู้เขยีนประกาศตวัแปรทีช่ือ่ว่า 

strVal ในบล็อกค�าสั่งของลูป For ส่งผลให้ตัวแปร

ตัวนี้มีขอบเขตการใช้งานเฉพาะภายในบล็อกของ

ลูป For Next นี้เท่านั้น 

จากรูปที่ 2-5 ข้อผิดพลาดที่ปรากฏขึ้นมา เกิดจากตัวแปร strVal ยังไม่มีการประกาศใช้งาน เพราะว่าเรา

เรียกใช้งานตัวแปรตัวนี้เกินขอบเขตของมันนั่นเอง

ทำ�หม�ยเหตุเอ�ไว้ด้วยเครื่องหม�ย "

แสดงข้อผิดพล�ด

เอ�หม�ยเหตุออก


